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ODBC Installation
 and User Guide



The Systems House, Inc.

Customer Reporting System 2

Notes:

_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
____________________________________________________________________

Introduction
 ODBC 4.0 Client

 For use with Reporting Tools

Introduction
The first section of ODBC training guide describes
how to install, configure, and use UniVerse ODBC
drivers on client systems.
The second section of the ODBC training guide
shows you how to add, delete, and/or change
dictionary fields in a specific file, as well as it’s
accompanying reports.
The third section of the ODBC training guide will
show you how to create queries in Excel, using a
single file.
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ODBC 4.0 Client Installation

Installation
On your PC, download the ODBC drivers .ZIP file to
your hard drive.  Extract all files to a folder.
Go to the folder, then click on the folder “ODBCCLI”
Click on the folder “I386”
Then double click on the setup.exe file to start the
installation process.
Click on the “NEXT” button throughout the
installation process to install the software into the
default directory.

Note: You must have administrator privileges to
install the drivers and data sources.
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UCI Editor
 Adding New Data Sources

UCI Editor
Adding New Data Source
Once the ODBC 4.0 client is installed, you will need
to add the data source to the UCI Editor.  This
process creates the connection to your server.
Go to Start -> All Programs -> IBM U2 -> UniVerse
ODBC Driver -> UCI Editor
In the UCI Editor, right click on “[ODBC DATA
SOURCES], then click on “ADD”.
A “New Data Source” box will be displayed.
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UCI Editor p2
 Adding New Data Source

UCI Editor
Adding New Data Source
Please enter source name: Enter your server’s
name.
DBMSTYPE: Select “UNIVERSE” as the database
type.
Please enter host name: Enter the host name, or
ip address, of your server.

When completed, click on the “OK” button.  The
information just added will now be showing in
window titled “Data Source Adding”.  From here,
click on “SAVE”.
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UCI Editor p3
 Adding New Data Source

UCI Editor
Adding New Data Source
To complete the process, click on File -> then click
on Exit.  The system will prompt:
“Do you want to save the changes you have made to
file C:\IBM\UniDK\Config\uci.config”
Click on “Yes” to save the changes.
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Creating a New File Data
Source Name
 For use with Reporting Tools

Creating A New File Data Source Name
This step will create a file data source name to use in
reporting tools such as: Excel, Crystal Reports, and
Access.

Click on Start -> click on Control Panel -> click on
Administrative Tools -> click on Data Sources
(ODBC)
From here, click on the tab labeled “File DSN”, then
click on the “ADD” button to create a new File DSN.
See example on the left of page.

A box titled “Create New Data Source” is displayed.
Click on the driver “IBM UniVerse ODBC Driver”, then
click on “Next”.
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Creating a New File Data
Source Name p2
 For use with Reporting Tools

Creating A New File Data Source Name
While creating the new data source, you must give it
a name, type in the name of the file data source you
want to save the connection to.  Then click on the
“Next” button.

The last screen titled “Create New Data Source” is
displayed.  The data source configuration that was
just created is listed below.  To save information,
click on the “FINISH” button.  To make any
necessary changes, click on the “BACK” button.
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Creating a New File Data
Source Name p3
 For use with Reporting Tools

Creating A New File Data Source Name
UniVerse ODBC Data Source Setup
Server: Enter the server’s name (source name) that
was used when creating the data source in the UCI
Editor.  You can click on the drop down arrow next
to the field and choose your server name from the
list.
Database: Enter the MDS Database name.  The
standard MDS Database name is:
YOURACCOUNTNAME.ODBC
User: Enter the user’s login
Password: Enter the user’s password.

Once completed, click on the button “Test
Connection”.  If the data source is setup correctly,
you should receive the message, “Connection
passed”.

Next, click on “OK” to save the file data source.
Once saved, you should be able to see the data
source listed (as in example on right).
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Creating a New File Data
Source Name p4
 For use with Reporting Tools

Creating A New File Data Source Name
Data Source path
The next 2 slides walks you through saving your
password on the system.  These steps alleviate the
need for the user to enter in his or her password
every time they connect to their MDS database,
while using a reporting tool, such as Excel.  This step
is OPTIONAL.

Click on the drop down arrow listed as “Data
Sources”.  Take note of the directory path that
this .dsn is located in.  In the example, the data
source is located in C:\Program Files\Common
Files\ODBC\Data Sources
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Creating a New File Data
Source Name p5
 For use with Reporting Tools

Creating A New File Data Source Name
Adding User’s Password to DSN file
Go to Start -> click on Run -> type “NOTEPAD” and
hit <ENTER>.  The notepad program should open on
the screen.  Go to the path that the file data source
is located.

Next, go to the drop down box titled “Files of type”
and select “All Files”.  You should now see your data
source.  Click on your data source and choose
“Open”.
Go to the bottom of the file, and on the next line
add:

PASSWORD=enter user’s password    -See example
on right

When completed, click on “File” then “Save”.  You
can then close out of Notepad.

Now, when using Excel or another reporting tool,
you will be able to use this file data source.
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MDS ODBC Administration
Menu

MDS ODBC Administration Menu
The MDS ODBC Administration Menu is located off
the MDS Utility Menu.
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MDS ODBC Administration Menu

MDS ODBC Administration Menu
Menu items discussed on following pages of
guide:

ODBC File Setup and Maintenance

Reports
ODBC Dictionary Listing
ODBC Dictionary Listing for an Account

ODBC Data Dictionary
ODBC MDS Tables by Area
ODBC Tables with Field Listings
ODBC Field Dictionary
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ODBC File Setup and
Maintenance
 Overview
 Changing a File

ODBC File Setup and Maintenance
Overview
In this program, you can add, change, and/or delete
fields and files for ODBC accessibility.  MDS provides
1 standard ODBC account, which only TSH personnel
have access to change.  If changes need to be made,
an additional ODBC account can be created.
Changes that need to be done, by your staff, would
only be done on this additional account.
In this example we will make a change to a existing
field.
ODBC Account – Enter the ODBC account and hit
<ENTER>. The standard MDS Database name is:
YOURACCOUNTNAME.ODBC
Data Account – Enter the data account and hit
<ENTER>.  This is your account name.
Data Filename – Enter the file name that you wish
to change.
All of the dictionaries for the selected file are
displayed.  To change a dictionary, just click on the
dictionary name or type the corresponding number in
and hit <ENTER>.
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ODBC File Setup and
Maintenance
 Changing a File continued

ODBC File Setup and Maintenance
Changing a File continued
You are now on that field, see above.  You can
change the field you are on, or hit <ENTER> to
advance to the next field.  You may also click on any
field to just change that field.
MDS Field Name - Enter the dictionary name. You
may enter NEW for temporary dictionaries (NOT for
ODBC definition).
ODBC Field Name - Enter the field name for ODBC
or the temporary dictionary name.
Fld - Enter the field attribute number for this field.
Description - Enter Description of this field.
MV - If this field is multi-valued, enter M to make
sure the ODBC processing recognizes this field as
multi-valued.
Jus – Justification; R – Right, L – Left, RN – Right
Numeric.
Len - Enter the length of this field.
Conversion Correlative - Enter the conversion
code to use. Valid codes include date conversions
(D , D2/ , DY, etc.), Numeric conversions (MR2 ,
MR2,M , MR2 , etc.), Text extraction (T1,5 , T10 ,
etc.),
Group extraction (G*1, G2*1 , etc.), File translation
(Tfilename;X;1;1).
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ODBC File Setup and
Maintenance
 Saving Changes

ODBC File Setup and Maintenance
Saving Changes
When completed making changes, click on the
“OK/END” button, or hit <F2>,  to go to the bottom
of the screen.

ENTER LINE# TO CHANGE,ADD,DELETE TO
DELETE,0 TO ACCEPT:
To update your changes, click on the “Update”
button, or hit Shift+<F1>.
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ODBC File Setup and
Maintenance
 Adding a new file

ODBC File Setup and Maintenance
Adding a New File
If there is a file on the system, that has not been
added to your ODBC database, you can enter it in
the same ODBC Field Maintenance screen.
ODBC Account – Enter the ODBC account and hit
<ENTER>. The standard MDS Database name is:
YOURACCOUNTNAME.ODBC
Data Account – Enter the data account and hit
<ENTER>.  This is your account name.
Data Filename – Enter the file name that you wish
to add.
The system will prompt:
Would you like to setup NEWFILENAME  for
ODBC (Y/N)?:
Enter “Y” and hit <ENTER>.



The Systems House, Inc.

Customer Reporting System 18

Notes:

_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
____________________________________________________________________

ODBC File Setup and
Maintenance
 Adding a new file page 2

 Selecting Fields

ODBC File Setup and Maintenance
Adding a New File
To select all fields to be added for usage, click on the
button “Sel ALL” or hit the Shift+F1 function key.
You may also click on the MDS Field Name to choose
each field separately.
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ODBC File Setup and
Maintenance
 Adding a new file page 3

 Deselecting Fields
 Saving Changes

ODBC File Setup and Maintenance
Adding a New File
When all fields are selected, you can deselect a
single field, by clicking on the MDS Field Name.
To deselect all fields, click on the button labeled,
“UnSel All”, or hit the Shift+F2 function key.

ENTER LINE # TO CHANGE,DELETE TO
DELETE, 0 TO ACCEPT:
When you are done selecting the fields, you can click
on the “OK/END” button to save your changes.
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ODBC Dictionary Listing

ODBC Dictionary Listing for a File
This report will generate a listing of all ODBC
dictionary fields for an ODBC file.

Enter ODBC Account Name (i.e. MDS.ODBC) –
Enter your ODBC account name and hit <ENTER>.
The standard MDS Database name is:
YOURACCOUNTNAME.ODBC

Enter ODBC File Name – Enter the ODBC file
name, then hit <ENTER>.

Sort Dictionary by (N)umber or
(A)lphabetically – Enter a “N” to sort the
dictionary fields on the report by their corresponding
number.  Enter “A” to sort the dictionary fields on
the report alphabetically.

Press <RETURN> to Process Report, Line# to
Change, or ABORT:
Hit <ENTER> to generate the report.  Remember: if
Report Capture is enabled, then the report will be
generated there.
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ODBC Dictionary Listing
continued
 Report output

ODBC Dictionary Listing continued
Shown above is an example of the report.
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ODBC Dictionary Listing for an
Account

ODBC Dictionary Listing for an Account
This report will generate a listing of all ODBC
dictionary files, and its’ fields,  for an ODBC account.

Enter ODBC Account Name (i.e. MDS.ODBC) –
Enter the ODBC account name and hit <ENTER>.
The standard MDS Database name is:
YOURACCOUNTNAME.ODBC

Sort Dictionary by (N)umber or
(A)lphabetically - Enter a “N” to sort the dictionary
fields on the report by their corresponding number.
Enter “A” to sort the dictionary fields on the report
alphabetically.

Press <RETURN> to Process Report, Line# to
Change, or ABORT:
Hit <ENTER> to generate the report.  Remember: if
Report Capture is enabled, then the report will be
generated there.
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ODBC Dictionary Listing for an
Account continued
 Report output

ODBC Dictionary Listing for an Account
continued
Shown above is an example of the report.
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ODBC MDS Tables by Area
 Selecting Report

ODBC MDS Tables by Area
This Crystal Report, will define each area of the MDS
system as well as list specific files in that area.  This
will help the user choose the appropriate files when
creating the query.

Once the report title is clicked, the system will open
the report in the Crystal Report viewer.

Note: You must have a data source already
configured to run this report.
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ODBC MDS Tables by Area
 Data Source Selection

ODBC MDS Tables by Area
Data Source Selection
The Select Data Source radio button should be
selected.
Under the field, Data Source Name, select your Data
Source Name from the list.
Then click on the “Next” button.
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ODBC MDS Tables by Area
 Connection Information

ODBC MDS Tables by Area
Connection Information
The server information is displayed.  This should
match the data source that was entered on the
previous page.
User ID – Enter your user id
Password – Enter your password

Click on the “Finish” button to display the report.
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ODBC MDS Tables by Area
 Report output

ODBC MDS Tables by Area
The report is displayed in the Crystal Reports viewer.
On the left hand side, the different system areas are
displayed.  By clicking on a system area, the viewer
will display the information regarding it on the right
hand side.
This report informs the user which files are related to
a specific area.
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ODBC Tables with Field Listings
 Selecting Report

ODBC Tables with Field Listings
This Crystal Report, will list all fields in a specific
MDS file.  This will help the user choose the
appropriate fields when creating the query.

Once the report title is clicked, the system will open
the report in the Crystal Report viewer.

Note: You must have a data source already
configured to run this report.
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ODBC Tables with Field Listings
 Data Source Selection

ODBC Tables with Field Listings
Data Source Selection
The Select Data Source radio button should be
selected.
Under the field, Data Source Name, select your Data
Source Name from the list.
Then click on the “Next” button.
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ODBC Tables with Field Listings
 Connection Information

ODBC Tables with Field Listings
Connection Information
The server information is displayed.  This should
match the data source that was entered on the
previous page.
User ID – Enter your user id
Password – Enter your password

Click on the “Finish” button to display the report.



The Systems House, Inc.

Customer Reporting System 31

Notes:

_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
____________________________________________________________________

ODBC Tables with Field Listings
 Report output

ODBC Tables with Field Listings
The report is displayed in the Crystal Reports viewer.
On the left hand side, all of the MDS ODBC files are
displayed.  By clicking on a file name, the viewer will
display all of the associated field on the right.
This report informs the user which fields are located
in a specific MDS ODBC file.
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ODBC Field Dictionary
 Selecting Report

ODBC Field Dictionary
This Crystal Report, will list specific information
regarding a field, and what MDS ODBC file it is
located in.  This will help the user choose the
appropriate fields when creating the query.

Once the report title is clicked, the system will open
the report in the Crystal Report viewer.
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ODBC Field Dictionary
 Data Source Selection

ODBC Field Dictionary
Data Source Selection
The Select Data Source radio button should be
selected.
Under the field, Data Source Name, select your Data
Source Name from the list.
Then click on the “Next” button.
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ODBC Field Dictionary
 Connection Information

ODBC Field Dictionary
Connection Information
The server information is displayed.  This should
match the data source that was entered on the
previous page.
User ID – Enter your user id
Password – Enter your password

Click on the “Finish” button to display the report.
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ODBC Field Dictionary
 Report output

ODBC Field Dictionary
The report is displayed in the Crystal Reports viewer.
On the left hand side, all of the MDS ODBC field
dictionaries are displayed.  By clicking on a MDS
ODBC Field Dictionary name, the viewer will display
the fields, with it’s description, on the right.
This report informs the user where a specific field is
located on the system.  For example, MDS ODBC
Field Dictionary ACCEPT_BO, is located in the table
PROD.MAST.
This report is useful when creating queries using
multiple files.
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Creating New Queries

Creating New Queries
To create a new query through Microsoft Excel,
follow the steps below.  At this point, Microsoft Excel
must be installed on your pc.
Open a new workbook in Microsoft Excel.
Go to Data -> Import External Data -> New
Database Query.
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Creating New Queries

Creating New Queries
A “Choose Data Source” box will appear, select your
data source that was created earlier.
Once it is chosen, click on the OK button.



The Systems House, Inc.

Customer Reporting System 38

Notes:

_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
_________________________________________________________________________
____________________________________________________________________

Creating New Queries

Creating New Queries
At this point, the system will try connecting to your
data source.
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Creating New Queries
 Without Password

Creating New Queries
If a password was not saved, then the system will
display the “UniVerse ODBC Data Source Setup” box.
 You will need to enter your password, then click on
the “OK” button.
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Creating New Queries
 Query Wizard

 Tables and Columns
Example 1

Example 2

Creating New Queries
Query Wizard - Choose Columns
The Query Wizard is displayed, and the “Choose
Columns” box will appear.  On the left hand side,
under “Available tables and columns”, the MDS
ODBC tables are displayed, double click on the table
you want to use.  For example, scroll down and
double click on CUST.MAST.  See example #1.

Underneath the CUST.MAST table, you can choose
your column names (ODBC fields).  Either double
click or highlight the column and hit the “>” button.
For this example, choose A_CUST_NO, NAME, and
AR_BAL, and then click the “Next” button.  See
example #2.
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Creating New Queries
 Query Wizard

 Filter Data
Example 1

Example 2

Creating New Queries
Query Wizard – Filter Data
If you want to filter your query to include only a
portion of the data, this section filters the query for
you.  See example #1.
Column to filter – Click on the column you wish to
use.  For this example, I am using AR_BAL.
Only include rows where – click on the drop
down arrow to select the operation you wish to use.
You will then be forwarded to the next field where
you then enter the data you want in the list on the
right.  For this example, I chose, under field, “Only
include rows where” to be equal to “is greater than
or equal to”, and entered “1.00” in the column on
the right.  See example #2.
You can also filter the query further, by clicking on
the radio buttons, “And” or “Or”.

Once completed, click on the “Next” button.
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Creating New Queries
 Query Wizard

 Sort Order

Creating New Queries
Query Wizard – Sort Order
If you want to sort your data, choose how you want
this done here.
Sort by – Click on the drop down arrow and choose
a column in the “Sort By” field, then click the sort
order that you want, Ascending or Descending.  For
my example, I chose “A_CUSTNO” and the
Ascending radio button.

Once completed, click on the “Next” button.
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Creating New Queries
 Query Wizard

 Finish

Creating New Queries
Query Wizard – Finish
If you wish to save this Query for future use, click on
the button “Save Query…”

To just return the data to Microsoft Excel, click on
the “Finish” button.
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Creating New Queries
 Query Wizard

 Finish
 Saving Query

Creating New Queries
Query Wizard – Finish
Saving Query
You will only see the “Save As” box, if you chose the
options “Save” or “Save As”.

Choose the default name or change the name, then
click on the “SAVE” button.
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Creating New Queries
 Query Wizard

 Finish

Creating New Queries
Query Wizard – Finish
The default placement of the data is $A$1 in the
existing worksheet.  You can change this if you want
to.  Then click on the “OK” button.
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Creating New Queries
 Query Wizard

 Data

Creating New Queries
Query Wizard
A simple, one file query is displayed.
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Editing a Query Through
Excel
 In Excel

Editing a Query Through Excel
First, run the query and have the results displayed on
your screen.
Then, right click anywhere on the results, and
choose “Edit Query…”.  See example.
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Editing a Query Through
Excel

Editing a Query Through Excel
This system will connect to your data source and
return the message:
“This query cannot be edited by the Query Wizard.”
Click “OK” to continue.
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Editing a Query Through
Excel

Editing a Query Through Excel
The system will then open Microsoft Query.  From
here all changes can be made.
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Editing a Query Through
Excel
 Columns

Example #1

Editing a Query Through Excel
Columns
You can add and/or delete columns.
To add a column to your query you can:

1. Click on the drop down arrow that
corresponds with the next available column.  See
example #1.

2. Scroll through the table (in this example it is
CUST_MAST) and double click on the column name
to add.

3. Add the column from the toolbar.  See next
slide for help.
For example, scroll through the table CUST_MAST,
then double click on the column name “PHONE”.

To delete a column in your query, click on the
column to highlight it, and hit the delete key.
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Editing a Query Through Excel
 Columns

 Adding from Toolbar

Editing a Query Through Excel
Columns
Adding from Toolbar
From the Toolbar, click on “Records”, then click on
“Insert Column…”
The “Insert Column” box will display.
Field – Click on the drop down arrow and choose
the column name you wish to add.  For this example,
choose “PHONE”.
Column Heading – Custom column headings.  For
this example, use default.
Total – If this a total column, simply click on the
drop down arrow and choose a variable.  Your
options here are: leave blank (as in this example),
Sum, Avg, Count. Min, or Max.

When done adding a column, click on the “Insert”
button.
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Editing a Query Through
Excel
 Criteria Options

Editing a Query Through Excel
Criteria Options
From the toolbar, choose Criteria.  From here you
can add criteria or remove all criteria.
See the next slide to discussing adding criteria.
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Editing a Query Through
Excel
 Add Criteria

Editing a Query Through Excel
Add Criteria
Total – You can add a total selection, choices are:
Sum, Avg, Count, Min, and Max.  For this example,
leave it blank.
Field – All fields in the table are displayed.  For this
example, click on the drop down arrow and choose
“ZIP”.
Operator – Choose a Operator selector, choices
are: leave blank, equals, does not equal, is greater
than, is greater than or equal to, is less than, is less
than or equal to, is one of, is not one of, is between,
is not between, begins with, does not begin with,
ends with, does not end with, contains, does not
contain, like, not like, is null, is not null.  For this
example, choose “equals”.
Value – Enter a value.  For this example, enter a
valid zip code.

When finished, click the “Add” button.
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Editing a Query Through
Excel
 Changing CriteriaExample #1

Editing a Query Through Excel
Changing Criteria
To change to an existing Criteria Field, you can click
on the drop down arrow next to the field and choose
a new field.  See example #1.

To make a change to an existing Criteria Value, just
click on the value you wish to change and overwrite
it.
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Editing a Query Through
Excel
 Running Query in Microsoft Query

Editing a Query Through Excel
Running the Query
While in Microsoft Query, look for the button “(!)”,
this button is called “Auto Query”.  When this button
is depressed,  whenever a change is made to your
query, MS Query will automatically refresh your
query.  This feature is best used when only running
small queries.  You can simply turn this feature off
by verifying that the button is not depressed.

So, if the Auto Query feature is not enabled, you can
simply run your query at anytime by clicking on the
exclamation point.  See the circled items.
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Editing a Query Through
Excel
 Saving

Editing a Query In Excel
Saving
After making your changes, you can save your query
by clicking on “File” then choosing either “Save” or
“Save As”.
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Editing a Query Through
Excel
 Returning Data to Excel

Example #1

Example #1

Editing a Query Through Excel
Returning Data to Excel
To return the data to Excel, after making changes in
Microsoft Query, click on File -> Return Data to
Microsoft Office Excel.  See example #1.

Example #2 shows  the new information that was
added.
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Where to Get More
Information
 To contact support call 973-777-8050 or

fax 973-777-3063.
 To access the The System’s House

website the address is: www.tshinc.com
.

Comments:


